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  Excel Calculations Course Outline 

 

Day 1 Day 2 
Module 1 Formula Basics 

• Learn formula basics. 

• Work with basic functions 

• Absolute vs. relative reference 

• Show Formulas 

Module 4 – Linking Formulas 

• 3D Formula linking  

• External linking with workbooks 
 

Module 2 – Learn an Array of 
Functions 

• Lookup Functions 

• Math Functions 

• Statistical Functions 

• Text Functions 

• Logical Functions 

• Date & Time Functions 

Module 5 – Data Analysis Tools 

• Data Tables 

• Goal Seek 

• Solver 

• Data analysis add-ins 

• Sampling  

• Histogram 

Module 3 - Conditional Formatting 
with Formulas 

• Compare data outside the 
conditional formatted range. 

• Use icons for key performance 
indicators 

Module 6 – Calculate with PivotTables 

• Refresh and modify PivotTables. 

• Calculate fields. 

Appendix A – Nesting Functions 

• Nesting with the syntax. 

• Nesting with the Function Box 

Appendix B – Range Names 

•  Create range names. 

• Apply and modify range names 
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Class Files Access 

Class files for this course can be found on the website, 

 www.windwardstc.com 

Click on the Courses page and then the Class Files tab. Select the link to 

your course and download the files.  
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Module 1 – Formula Basics 

This lesson is a review of the basic formula and functions observed in earlier courses.  

 

 

 

• Learn formula basics. 

• Work with basic functions 

• Absolute vs. relative reference 

• Show formulas. 

• Grouping sheets 
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Learn Formula Basics 

 

Open the file “Crystal Clear Sales Formulas and Functions.” 

Save as: “My Crystal-Clear Sales Formulas and Functions” 

Excel formulas are instructions that perform calculations in worksheets. To start the formula in Excel all 

you need to do is type an = sign.  

The formulas will commonly contain references to a cell or a range of cells on worksheets referring to 

the location of the data that you want to apply it to.  

Sample Formulas 

 =B5+B6+B7+B8 

 = (B5+B6+B7+B8)/4 

The formulas also contain operators which specify the type of calculation that will be performed on the 

various components of the formula. 

The common math operators Excel uses are: 

 
()  Parenthesis 

^  Exponent 

*  Multiply 

/ Divide 

+ Add 

- Subtract 

Order of Operations: 
When you are using a combination of operators there is a sequence of computations that determine the 

results of the formula. That sequence is displayed above with the math operators. The order begins with 

Parenthesis and ends with Subtraction.  

 

Examples:  4 + 6 / 2 = 7 

  (4 + 6)/ 2 = 5 
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Formula Examples: 

 

The formula was typed in 

cell B10 and is displayed 

in the formula bar. The 

value is in the active cell. 

Note:  

There is no + sign after 

B9 in the formula since 

there is nothing to add 

after it. 

 

 

 

 

 

 

The formula in cell B11 

shows the order of 

operations used to calculate 

the average sales for Jan. 

 

 

 

 
Tip: You can copy the formulas across the columns or rows using the “Fill Handle”. 
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Work with Basic Functions: 

 
Excel functions are predefined formulas. There are over 300 functions in the program and can be very 

useful in speeding up the calculation process.  

 

Examples of Common 

Functions: 
 =Sum (B5:D5)  

 =Average (B5:D5) 

 =Max (B5:D5) 

=Min (B5:D5) 

 =Count (B5:D5) 

 

 

Excel Functions must have the following components: 

 =Sum(B5:D5)  

An equal sign 
 

 
A function name 

 
An argument 

 

Functions can be entered in a variety of ways: 
1. Typed in the cell 

2. Inserted with Auto Function 

3. Created with the Function Library 

4. Started with Auto Complete 
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Function Practice: 

Using the “My Crystal-Clear Sales Formulas and Functions” file 
A. Start with the sheet tab Qtr 3. 

B. Type the sum function to figure the January Totals in the Water products. 

C. Use the Average function from the Auto Function command list to figure the January averages 

for Water products. 

D. Use the Max function from the Function Library group in the Formulas tab.   

(Hint:  Look under More Functions, then Statistical.) 

E. Complete all the functions for water products by copying them with the fill handle. 

F. Complete all the functions for dispenser products with your preferred method. 

 

Completed Sample: 
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Absolute vs. Relative Reference 

 

Using the “My Crystal-Clear Sales Formulas and Functions” file 

 

 

Absolute References: 
Based on the layout of the worksheet some formulas require the use of absolute references. When you 

use the fill handle to copy cell formulas Excel, by default, uses relative references. Relative references 

automatically adjust the column or row indicator when you copy them using the fill handle. You can 

create an absolute reference to keep the cell(s) from adjusting.  

Method: Placing dollar signs before the column or row reference in a cell will make it absolute. A quick 

method of creating an absolute reference is to select the reference and use the F4 function key.  

 Steps: 

1. In cell G1 add the label Commission Rate. 

2. In cell H1 add the amount of 10%. 

3. Create a Commission column in cell F3. 

4. In cell F4 create a formula to multiply E4 with H1 to come up with the commission. 

5. Use the fill handle to copy the formula down to cell F8. 

6. Notice the cells are empty.  

7. Select cell F4 and view the formula. 

8. Select cell F5 and view the formula. 

9. By default, Excel uses Relative referencing.  

10. You need to make cell H2 and absolute reference. $H$2 
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Show Formulas 

 

Excel provides a great visual to see the formulas for multiple cells on the spreadsheet rather than 

looking one at a time on the formula bar. 

Select the Formulas tab and in the Formula Auditing group click the Show Formulas tab. 

You can also use the keyboard shortcut CTRL + ~ (Tilde) 
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Grouping Sheets 

One of the most beneficial time savers in Excel is the group sheets feature. Hours may be spent trying to 

make all your sheets in a workbook have the same formatting, formulas, and other elements, such as 

column sizes to provide a common look.   

You can group all sheets or just chosen sheets in a workbook using a few mouse clicks. 

• Right-click a sheet tab and choose “Select all Sheets”. 

• Select a sheet then hold down the Shift key and select the last sheet you choose to group.  

• To select non-adjacent sheets, start with selecting a sheet and use the CTRL key to select the 

other sheets.  

The value of grouping sheets is that when they are “grouped”, everything you do on one sheet is done 

on all the other sheets at the same time. The title bar will display (Group) when sheets are grouped. 

If you were working on expenses for your organization, you could create a workbook with 12 or 13 

sheets. Name each sheet with the prospective Year, and then group all the sheets.  Now all you need to 

do is enter the labels, formulas and formats to all 12 or 13 sheets at the same time. When you are done 

you can save it as a template and make it available for future years. 

Here is an example of grouped sheets by product in an expense’s workbook showing a consistent layout: 

 

Create a new grouped workbook: 

• Start with a blank workbook. 

• Save the file in the class folder as “My Expenses.xls “  

• Name the sheets 2019, 2020, 2021 and group them 

• Using the above sample, input the expenses, months, and totals 

• Format as desired and ungroup the sheets to see your work. 
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Module 2 – Learn an Array of Functions  

There are over 400 functions in Excel. This module will explore an array of 6 categories of them. 

We’ll use lookup functions to extract data, math functions to calculate, statistical functions to 

average and count cells, text functions to combine and extract data, logical functions to solve 

true/false questions and date & time functions to calculate time parameters.  

 

 

• Lookup functions 

• Math functions 

• Statistical functions 

• Text functions 

• Logical functions 

• Date & time functions 
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Lookup Functions 

 

The lookup functions search through datasets and return a value based on some criteria.  

 

Open the file “Lookups.”     

Save it as “My Lookups.” 

 

Common Lookup Functions: 
 

VLOOKUP   

Looks for a value in the leftmost column of a table, and then returns a value in the same row from a 

column you specify. By default, the table must be sorted in ascending order. 

HLOOKUP Function  

Looks for a value in the top row of a table or array of values and returns the value in the same column 

from a row you specify.  

INDEX Function  

Returns a value or reference of the cell at the intersection of a row or column, in a given range. 

MATCH Function  

Returns the relative position of an item in an array that matches a specified value in a specified order. 
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VLookup Function 
Looks for a value in the leftmost column of a table, and then returns a value in the same row from a 

column you specify. By default, the table must be sorted in ascending order. 

The two most important parts of a VLOOKUP are: 

1. The left most column of the “table array” you use in the VLOOKUP is sorted in ascending order. 

2. The table array in the VLOOKUP is used as an absolute value. Easiest is to give the table a named 

range. Named ranges are always absolute when you first create them. 

VLOOKUP Example: 
 

 

 

 

 

 

 

 

Practice: 
Open the file “Lookup” Save it as “My Lookup”. 

A. On the VLOOKUP sheet tab select cell B2 to create a VLOOKUP to find the Sale Amounts from 

the order numbers in column A.  

B. Remember the two most important steps. 

Completed Example: 
 

 

 

 

 

 

Close the “My Lookup file”.  
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Open the file “Lookups Functions”. 

Save it as “My Lookups”. 

Practice VLOOKUP: 

Select the H&V Lookups tab. 

1. Create a Vlookup in cell C5.    

2. Lookup value is B3. 

3. The Table Array is “Prices”. 

4. Column and index_num is 3. 

5. Range_lookup is False. 
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HLookup Function 
Looks for a value in the top row of a table or array of values and returns the value in the same column 

from a row you specify. 

Note: In this example the “Range Lookup” property is True, which looks up values that are the closest 

match instead of exact. 

HLOOKUP Example:  

 

Practice:  

 
A. Select the sheet tab HLookup. 

B. Choose cell F5 to start the HLookup 

function.   

C. The lookup_ value is E5. 

D. The table_ array is Shipping. 

E. The row_index_num is 2. 

F. The Range_Lookup is True. 

 

 

 

Completed Example: 
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INDEX and MATCH Function: 
In the example below the INDEX function is nested with the MATCH function to provide the Product ID 

in cell B2. 

 

Completed Example: 
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MATCH Function 
Returns the relative position of an item in an array that matches a specified value in a specified order. 

Note: #N/A is returned when there is no match found on the list. 
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Math Functions 

 

Calculate with Sum functions that include criteria to help analyze data within ranges of cells. 

 

 

 

• SumIf 

• Sumifs 

• Round 
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SumIf and If’s Functions 
 

1) The Sum IF function includes the option to select a criterion, like a Region, to analyze within a 

range of cells and bring back results specific to the criteria.  

2) The Sum IF’s function includes the options to select multiple criteria, like a Region and 

Department and bring you the results for the criteria that match.  

 

 

SumIf Example 

 

 

SumIfs Example 
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Statistical Functions 

There are an extensive range of statistical functions available in Excel. The If’s functions were added in 

the 2007 version of Excel and have simplified using multiple criteria sections like with database 

functions.   

Open the file “Statistical Functions: 

 

Common Statistical Functions: 
 

Average  

Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays or 

references that contain numbers.  

 

Average IF 

Finds average (arithmetic men) for the cells specified by a given condition or specified criteria.  

 

Average If’s 

Finds average (arithmetic men) for the cells specified by a given set of conditions or specified criteria.  

 

Count  

Counts the number of cells in a range that contain numbers. 

CountIf  

Counts the number of cells within a range that meet the given condition. 

CountIfs 

Counts the number of cells specified by a given set of conditions or criteria. 
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Average, Averageif, Averageifs  
Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays or 

references that contain numbers. 

There are many variations of the Average function. AVERAGE, AVERAGEIF, AVERAGEIFS. 

1) The basic Average function has a simple argument requesting only the range of cells to give you 

the average.  

2) The Average IF function includes the option to select a criterion, like a person’s name, to 

analyze within a range of cells and bring back results specific to the criteria.  

3) The Average IF’s function includes the options to select multiple criteria, like a person’s name 

and product group and bring you the results for the criteria that match.  

 

 

AVERAGEIF Example: 
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Count, CountIf, CountIfs   
 

Counts the number of cells in a range that contain numbers. 

Just like the previous function the COUNT function has many variations. 

1) The basic Count function has a simple argument requesting only the range of cells to give you 

the count of numbers in a range of cells. 

2) The CountIf function includes the option to select a criterion, like a person’s name, to analyze 

the count from within a range of cells and bring back the results specific to the criteria. 

3) The CountIfs function includes the options to select multiple criteria, like a person’s name and 

product group and bring you the results for the criteria that match. 

 

 

COUNTIFS Example: 
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Text Functions 

Text formulas are good for combining text strings together. Like the Concatenate function. You can use 

them to extract pieces of a text string and build a linked value from those pieces. An example would be 

to join the first name and last name together for a complete full name column. 

The LEFT and RIGHT functions are great for extracting pieces of a text string that can be applied to other 

text strings for later use. Like 4 characters from the right of a text string to retrieve the last for 

characters of a credit card number for verification purposes.  

Often when you download data from a database the information you need is not broken down or 

formatted as needed. Text functions help you perform global cut and paste type actions that can save 

you hours of time. 

Open the file “Excel Text Functions”.  Save it as “My Excel Text Functions”. 

Left Function Example: 1st four characters from the left of the text string in cell A2. 

=LEFT(A2,4) 

 

 

 

 

 

 

 

Mid Function Example: 3rd and 4th characters from the middle of the text string in cell A2. 

=MID(A2,3,2) 
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More Text Functions: 
Continuing text functions we will explore the right function. 

Right Function Example:  Last 2 characters from the right in cell A2.   

=RIGHT(A2,2) 

 

 

 

 

 

 

 

 

 

Len Function Example:   The number of characters in cell A2. 

=LEN(A2) 

 

 

 

 

 

 

 

 

Find Function Example:   Find the first dash in cell A2. 

=FIND("-”, A2,1) 
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Text Function Practice: 

 

Open the file “More Text Functions”  

Save it as “My More Text Functions” 
 

A. In cell D2 use the Left function to extract 2 characters from the left of cell C2. (Campus info) 

B. In cell E2 use the Mid function to extract 2 characters from the middle of cell C2. (Building info) 

C. In cell F2 use the Right function to extract 4 characters from the right of cell C2. (Floor info) 

D. In cell G2 use the Concat function to join the first and last names from cells A2 and B2. 

 

Completed Example: 
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Logical Functions 

Open the file “HR List” 

Save it as My HR List. 

 
Logical functions let you ask questions about your data and provide answers for you. The answer to the 

questions can return one of two values, TRUE or FALSE.  

To help ask the questions you need there are comparison operators like: 
=  Equal to 

> Greater than 

< Less than 

>=  Greater than or equal to 

<= Less than or equal to 

<> Not equal to 

 

Common Logical Functions 
IF, AND, OR, TRUE, FALSE, IFERROR 

IF Function   

Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE. 

AND Function  

Checks whether all arguments are TRUE and returns TRUE if all arguments are true. 

OR Function  

Checks whether any of the arguments are true and returns TRUE or FALSE. 

TRUE Function  

Returns the logical value TRUE 

FALSE Function   

Returns the logical value FALSE 

IFERROR Function  

Returns a value if an expression returns an error 
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IF Function: 
The IF Function is a conditional formula that returns one value if the condition is true and another value 

if the condition is false.   

 

The proper syntax is:  =IF (Logical Test, value if true, value if false) 

Example:    If the employee has been employed more than 5 years, they are 401K eligible.  Yes/No 

 

To Locate the IF function: 
A. Select the Formulas tab. 

B. In the function library choose the Logical group. 

C. Select the IF function. 

Or: 

A. Type =IF and view the auto complete menu that appears. 

B. When the If function is highlighted use the tab key to select it. 

C. Click the fx function command next to the formula bar to activate the 

formula arguments box.  
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IF Function Practice: 
A. Open the HR List file. Save it as My HR List 

B. Select the sheet tab Retirement. 

C. In cell G5 create an IF function to determine the 401K eligibility after 5 years of service. 

D. =IF(F5>=5,”Yes”,”No”)  

E. Save your work. 
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AND Function 
Checks whether all arguments are TRUE and returns TRUE if all arguments are true. The AND function is 

also commonly used as a nested function to add multiple criteria to the IF function. 

Example from Excel’s Help screen. 
 

 

 

 

 

 

 

 

AND Practice: 

A. Create a spreadsheet using the example below.  

B. Use an AND function to determine their 401K eligibility. 

a. Employees must have 5 years of employment to start 401 K’s. 

b. Employees can’t work past 50 years with company. 

 

 

 

Completed Example:  
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OR Function  
Checks whether any of the arguments are TRUE and returns TRUE if any of the arguments are true. The 

OR function is also commonly used as a nested function to add multiple criteria to the IF function. 

Example from Excel’s Help screen. 

 

 

 

 

 

 

 

 

 

 

 

 

OR Practice: 
A. Create a spreadsheet using the example below. 

B. Use an OR function to determine how many team members choose Green and Red for team 

colors. 

 

Completed Example:  
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TRUE and FALSE Functions: 

 

Select the True False sheet tab  

 

True: Returns the logical value TRUE 

False: Returns the logical value FALSE 

 
 =A11=B11 displays TRUE 

 

 

 

 

 

 

 

 

 

 

=A11-B11 displays FALSE  

   



  

34 
 

IFRRROR Function: 
 

The IF ERROR function returns a value if the expression is an error and a value of the expression 

otherwise.   

The example below uses the MATCH function to compare two lists, column G and Column A. It returns 

the #N/A error when there is no match. When there is a match it returns the position, it is on the list.  

Using the IFERROR function you can use whatever words you choose to display instead of the error. 

Such as: No Match. 

 

IFERROR Example: 
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Date & Time Functions 

 

Open the “Dates” file. 

 
Microsoft Excel stores dates as sequential numbers that are called serial values. For example, January 1, 

1900 is serial number 1, and January 1, 2008 is serial number 39448 because it is 39,447 days after 

January 1, 1900. If you format a cell that contains a date with the “General” format it will display the 

serial number. 

 

Often you will want to find the difference between ranges of dates.  Like how many years of 

employment or how many days’ shipments are taking. This can be done with simple formulas and 

enhanced with date functions. 

=B2-A2 

 

Common Date Functions: 

• Today  Displays the date only  =Today() 

• Now  Displays the date and time =Now() 

The Today and Now functions update the current date when the file is opened or modified. 
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Date Formula and Function Practice: 

Class Group Exercise: 
A. Open the My HR List file and select the Employment sheet.  

B. Link the “Date of Hire” column with the same column on the Payroll sheet. Copy to row 50. 

C. Select all the dates for the “Date of Hire” column and format them as a General format to view 

the serial numbers. Format them again as any date format of your choice. 

D. In cell H2 use the Today function to create an updating current date. 

E. In cell E5 create a formula to figure days employed using today’s date and the hire date. Use the 

fill handle to copy the formula to row 50. (Hint: Must use absolute references) 

F. In cell F5 create a formula to figure years employed.  

Completed Sample: 
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Module 3 – Conditional Formatting with 
Formulas: 

 

  

• Compare data outside the conditional formatting range 

• Use icons for key performance indicators (KPI)  
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Compare Data Outside the Conditional Formatting Range 

 

Open “Conditional Formatting” file 

Save as “My Conditional Formatting” 
 

You can use a formula to apply conditional formatting to a range of cells based on data entered in other 

cells.  

A. Choose the “Annual Total” sheet tab. 

B. Select cells A4 through A13 and create a New conditional format for the selected range. 

C. Choose the rule type “Create a formula to determine which cells to format. 

D. Enter the formula     =$B4>3000000 

E. Format as a red font. 

F. Click OK 

G. Quarter 2 through Quarter 4 should be a red font. 

 

 

 

  



  

39 
 

Use Icons for Key Performance Indicators: 

 

Use conditional formatting to set up Key Performance Indicators from one quarter to the next to see 

progress. 
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Module 4 – Linking Formulas: 

 

 

 

 

• Linking within a workbook 

• External linking with workbooks 

• 3D formula linking 
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Linking within a workbook 

 

Open the file “3D Formulas.” 

Save as “My 3D Formulas” 
 

A. Select cell B5 in the Summary sheet tab. 

B. Start a SUM function.    =SUM (      

C. Click on the QTR 1 sheet tab and choose cell B5. 

D. Hold down the Shift key. 

E. Select the Qtr 4 sheet tab. 

F. Click enter to complete the formula. 

 

Completed Example:  
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External Links to Link Workbooks 

Open the file “External Links” 

Save as “My External Links” 

Open Qtr 1 through Qtr 4 Workbooks 

 

Note: The external links are created in the Destination file (“External Links”) 

The Qtr1 thru Qtr4 files are source files. 

 
A. Select the Summary sheet tab in the External Links file. 

B. Begin the link by typing =.in cell B3. 

C. Select the Qtr 1 file from the taskbar and select cell D22. (Total) 

D. Click enter to complete the link. 

E. Link the remaining 3 quarters. 

 

Completed Example: 

  
 

 

 

 

 

 

 

 

Warning!     If you change the name of any of the source files you can break the 

link. 
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Troubleshoot External Links 

Close the file” Qtr 1Sales”.  

Rename the file “Quarter 1 Sales”. 

 
When you rename a source file it will break any link it has to the destination files. 

A. In the “External Links” file on the Summary sheet tab, select the Data command tab. 

B. In the “Queries and Connections” group, select the Edit Links command. 

C. Try to open the Qtr 1 source file. You will get an error.  

 

 

 

 

 

 

 

D. Since the file name was changed the link was broken. 

 

 

E. Change the source file from Q1 Sales to Quarter 1 Sales 

Completed Example: 
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Module -5- Data Analysis Tools 

 

 

 

 

• Data Tables 

• Goal Seek 

• Solver 

• Data Analysis add-ins 

• Sampling 

• Histogram  
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Data Tables 

 

Open the “Data Tables” file 

Save as ‘My Data Tables 

 

Two Variable Data Table 
A. Link cell A8 with C6 (Where the PMT function is) 

B. Select A8 through K18. 

C. From the Data tab in the Forecast group click the What-if-Analysis arrow and choose Data Table. 

D. Select cell C4 for the Row input cell. 

E. Select C3 for the Column input cell. 

F. Click Ok. 

 
Completed Example: 

 

 

 
 

 

 

 

One Variable Data Table 
A. Link cell E8 with C6 (Where the PMT function is) 

B. Select D8 through E18 

C. From the Data tab in the Forecast group click the What-

if-Analysis arrow and choose Data Table.  

D. Select C4 for the Column input cell.  

E. Click Ok. 
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Goal Seek 

Open the “Goal Seek and Solver” file 

Save as My Goal Seek and Solver 
 

Goal Seek allows you to calculate the value of one input in order to arrive at a specific outcome. If you 

knew you could only afford $600.00 for your monthly payment on a loan you may attempt a trial and 

error process by changing the Principle Amount, the interest rate, or terms in months to set the monthly 

payment to what you can afford. This could be very time consuming. With Goal Seek you can set the 

monthly payment to a value of $600 and pick one changing cell and Goal Seek will find a solution for 

you.  

A. Select cell F4 

B. Navigate to the Data tab and 

What-if-Analysis command 

and choose Goal Seek. 

C. Set Cell is F4 

D. Value is 600 

E. Changing cell is D3 

F. Click OK 

 

 

Completed Example: 
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Work with Solver 

 
With Goal Seek it has limitations. It can solve only for a single value for a single variable. Excel has 

another tool that comes loaded with Excel but is not activated by default. To activate the solver tool, go 

to File, Options, then Add-Ins. At the bottom of the screen where it shows the Manage Excel Add-ins 

click the Go command. Check the box for the Solver Add-in. 

 

 

 

 

Look for the Solver tool on the Data tab in the Analyze 

group. 

 

 

 

 

 

 

 

 

 
A. Select cell F4 

B. Navigate to the Data tab and 

Analyze group and choose Solver. 

C. Set Cell is F4 

D. Value is 600 

E. Changing cell is D3, D5 

F. Add a Constraint. $D$5<=40 

G. Click OK 
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Data Analysis Add-Ins 
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Sampling 

 

The Sampling analysis tool creates a sample from a population by treating the input range as a 

population. When the population is too large to process or chart, you can use a representative sample. 

You can also create a sample that contains only the values from a particular part of a cycle if you believe 

that the input data is periodic. For example, if the input range contains quarterly sales figures, sampling 

with a periodic rate of four places the values from the same quarter in the output range. 

 

 

Completed Example: 
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Histogram 

Open the file “Histogram”  
 

A. Go to the Data tab and choose the Data Analysis tools in the Analysis group.  

B. Select Histogram 

C. Click OK. 

D. Choose your input Range. 

E. Choose your bin Range 

F. Choose you output Range 

 

 

 

Completed Example 

 

 

 

 

 

 

 

 

 

 
 

 

  



  

51 
 

Module 6 – Calculate with PivotTables 

PivotTables allow you to summarize large amounts of raw date by pivoting the columns and row data 

without altering the raw data. You can create them from Excel spreadsheets or other data sources like 

Access or SAP. They work best with the raw transactional data. Your fields are columns and your records 

are rows. 

 

Open the file “PivotTables” 

Save as “My PivotTables” 
 

Steps: 
1. To create a PivotTable, click a single cell inside the source data range. 

2. Go to the Insert tab and select the command for PivotTables on the left side of the ribbon 

 

 

 

 

3. Because the data was prepared properly the program picked 

up the entire range of cells. It shows the Orders Range Sheet 

along with the selected cells. 

 

4. Click OK to create the PivotTable. 

5. Select the necessary fields to analyze. 
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Refresh and change PivotTable data 
When data is changed in the original data source you need to refresh the data in you PivotTable. It does 

not refresh automatically. 

Steps: 
1. Change the data in your source sheet. 

2. Select a single cell in your Pivot Table 

3. From the PivotTable tools Analyze tab choose Refresh 

4. Watch for the update 
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Calculate Fields 
 

After creating PivotTables, you can add Calculated Fields to it. From the Analyze tab for PivotTable tools, 

look in the command Fields, Items, & Sets in the Calculations group. 

Create a new calculated field using the Sale Amount field and call it Commission. 

Name: Commission 

Formula:  =’SaleAmount’*.10 

 

 

 

Completed Example:   
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Appendix A: 

Nesting Functions 
When you use a function as one of the arguments in a formula that uses a function is called nesting.  In 

this exercise we will nest the IF and AND functions together. The IF function has a logical test as part of 

the argument. In most cases in the exercise we will nest the AND function with the IF function to allow 

us to have more than one logical test for the formula.  

Open the file “My Logical Functions”. 

• Select the sheet tab IF Function Practice 

• In cell C3 create an IF function to show the A grade in column C.      

• Use the Fill handle to copy the formula to row 13. 

 

 

 

 

 

 

 

 

In cell D3 create a nested IF function to show the B grade in column D. 

To do this you need to nest the AND function with the IF function to be able to have 2 logical tests. 

There are 2 ways to do this.  

1. Type the formula in with all the correct syntax.  =IF(B3<90,B3>=80,”B”,””) 

2. Use the Function Arguments box to nest the AND function to the IF. 
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Using the Function Arguments Box. 

Start with the IF function. 

Click in the Logical test text box. 

 

 

 

 

 

 

 

Go to the Name Box, now acting as a function box.   

Select the AND function, or click on more functions to find the AND function. 

 

 

 

 

Now the AND function is nested with the IF function. 

In the AND function box enter the 2 logical tests. 

 

 

 

 

 

 

 

 

 

Do not click OK. 
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To complete the nesting for grade B you need to finish the IF function argument. 

In order to get back to the IF function, click on the word IF in the formula bar. 

 

Fill in the Value if true text box with a B grade. 

Fill in the value if false with 2 quotation marks with no spaces. 

Click OK and use the fill handle to copy the formula to row 13. 

Use the same process to nest the C grade and the D grade. 

Use a regular IF function for the F grade. 
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Appendix B: 

Range Names: 
Naming ranges in formulas help you read a formula or function a little more naturally since many of the 

names refer to current titles in the worksheet. 

 

 

 

 

• Create range names 

• Apply and modify range names 
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Use Range Names in Formulas 
 

 An example would be 

1) Range of cells      =Sum (G2:G234)   

2) Named range  =Sum (January) 

 

Open the file “Range Names” 

Save as “My Range Names” 

 

Practice: 
A. Select the Names sheet tab. 

B. Create named ranges for each of the months. 

C. Create a named range for the commission rate in cell H3. 

D. Use the sum function to total all the months using the named ranges for the argument.  

 

 

Completed Example: 
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Common Keyboard Shortcuts in Excel 

 

Function Keys: Does This: 

F1 Displays the Help pane 

F2 Edit in the active cell 

F3 Displays the Paste Name box 

F4 Repeats the last action 

F5 Displays the Go To dialog box 

F6  Switches between the panes 

F7 Displays the Spell Check box 

F11 Creates a default chart  

F12 Displays the Save As box 

 

 

 

 

 

Workbook Shortcuts: Does This: 

Ctrl + N Create a new workbook 

Ctrl + O Open a workbook 

Ctrl + W Close a workbook 

Ctrl + S Save a workbook 

Ribbon Shortcuts: Does This: 

Alt Key Opens the Access keys 

Ctrl + F1 Expand/Collapse Ribbon 

Worksheet Shortcuts: Does This: 

Ctrl + X Cut selected data 

Ctrl + C Copy selected data 

Ctrl + V Paste selected data 

Ctrl + Z Undo last action 

Ctrl + Y Redo last action 

Formatting Shortcuts: Does This: 

Ctrl+1 Opens the Format box 

Ctrl+ B Bolds the text 

Ctrl+ I Italicizes the text  

Ctrl+ U Underlines the text 

Ctrl + Shift + $ Applies currency format 

Navigation Shortcuts: Navigates: 

Arrow keys One cell at a time 

Ctrl + Arrow keys Begin/End of Row/Column 

Home Column A Row 1 

Page Up /Down A screen worth of rows 

Tab Moves right one cell 

Shift + Tab Moves left one cell 

Ctrl + Home Moves to cell A1 

Alt + Page Up / Down Moves 1 screen left/right 

Misc.: Shortcuts: Does This: 

F4 Key in Formulas Applies absolute 
reference 

Ctrl + Shift + semi-colon Inserts current date 

Ctrl + Shift + colon Inserts current time 

Ctrl + Enter Complete entry and 
stay in same cell 

Alt + Enter Start a new line in 
same cell. 

Esc Cancel an entry in cell 

Data Entry Shortcuts: Navigate in active ranges 

Tab → 

Shift + Tab  

Enter  

Shift + Enter  

Selection Shortcuts: Selects: 

Shift +Arrow keys One cell at a time 

Shift + Ctrl + Arrows Begin/End of Row/Column 

Ctrl + * Entire “region” 

Ctrl + A Entire worksheet 

Shift + Spacebar Selects entire row 

Ctrl + Spacebar Selects entire column 
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Using Help to List All Excel Keyboard Shortcuts 

Note: To use Help you must be connected to the internet. 

To find all the keyboard shortcuts for Excel 365 use 
the F1 function key to open Help.  
 
You can also click on the Help tab and choose the Help 
command. 
 

 

Select the link for “Keyboard Shortcuts in Excel” 

 

Scroll down to the second Notes section and select 
the link for” Excel 2016 for Windows Keyboard 
Shortcuts”. 

 

It will open a Word document with all the keyboard 
shortcuts for Excel 365. 
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Notes: 
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Notes: 
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Notes: 
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Notes 


